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BIÊN TẬP TÀI LIỆU THAM KHẢO TRÊN TỆP MICROSOFT WORD                    
VỚI SỰ HỖ TRỢ CỦA PHẦN MỀM ENDNOTE

 TS. Trần Lê Nam(*), ThS. Phan Thị Hiệp(**)

Tóm tắt
EndNote là một phần mềm quản lý các danh mục tài liệu tham khảo khi viết bài luận và bài báo, 

được sản xuất bởi Thomson Reuters. Trong bài báo này, chúng tôi trình bày cách sử dụng phần mềm 
EndNote để thành lập ngân hàng danh mục tài liệu tham khảo, trích dẫn và sắp xếp tự động các tài liệu 
tham khảo trên tệp Microsoft Word, thay đổi định dạng trích dẫn và định dạng danh mục trong tài liệu 
tham khảo, tách riêng tài liệu tham khảo tiếng Anh và tài liệu tham khảo tiếng Việt.

Từ khóa: tài liệu tham khảo, trích dẫn, EndNote.
1. Giới thiệu
Việc ghi chính xác tài liệu tham khảo là một 

yêu cầu bắt buộc đối với các bài luận và bài báo 
khoa học. Tuy nhiên, nếu chúng ta thực hiện trích 
dẫn thủ công thì chúng ta thường gặp một số khó 
khăn như: sắp xếp thứ tự danh mục tài liệu tham 
khảo, đưa vào tài liệu tham khảo không có trích 
dẫn trong bài viết hoặc ngược lại, phải định dạng 
từng tài liệu tham khảo… Chính vì lý do đó mà tập 
đoàn Thomson Reuters đã sản xuất ra phần mềm 
EndNote để hỗ trợ quản lý danh mục tài liệu tham 
khảo [9]. Bên cạnh tài liệu hướng dẫn của nhà sản 
xuất [7], cộng đồng sử dụng EndNote nước ta đã 
biên tập nhiều tài liệu hướng dẫn sử dụng, cũng 
như thành lập kho dữ liệu riêng [2], [4], [8]. Khi 
chúng ta kết hợp phần mềm EndNote với phần 
mềm Microsoft Word thì các danh mục trong tài 
liệu tham khảo sẽ:

- Trùng khớp với các tài liệu tham khảo đã 
được trích dẫn trong bài viết;

- Tự động sắp xếp và định dạng;
- Có thể tách riêng hai danh mục tài liệu tham 

khảo tiếng Việt và tiếng Anh.
Hơn nữa, chúng ta có thể thay đổi kiểu trích 

dẫn, định dạng danh mục tài liệu tham khảo một 
cách nhanh chóng và sử dụng một cơ sở dữ liệu 
cho nhiều bài viết khác nhau. Chúng ta thực hiện 
công việc đó qua 3 bước:

- Xây dựng ngân hàng danh mục tài liệu tham 
khảo với phần mềm EndNote;

- Trích dẫn các tài liệu trong ngân hàng vào 
bài viết;

- Thay đổi định dạng các trích dẫn và định 
dạng các danh mục trong tài liệu tham khảo.

2. Biên tập tài liệu tham khảo trên tệp Micro-
soft Word với sự hỗ trợ của phần mềm EndNote

2.1. Cài đặt phần mềm EndNote
Chúng ta tiến hành cài đặt phần mềm EndNote 

theo các bước sau:
- Download bản dùng thử tại http://endnote.

com/downloads/30-day-trial hoặc bản đầy đủ tại 
https://www.dropbox.com/s/6sfozwtx1bgfc3k/
Endnote.rar?dl=0. 

- Mở tệp ENX7Install.exe vừa download về 
để tiến hành cài đặt. Sau khi máy tính khởi động 
cửa sổ cài đặt (Hình 1), chúng ta nhấp chuột trái 
vào nút Next. 

(*) Khoa Sư phạm Toán – Tin, Trường Đại học Đồng Tháp.
(**) Khoa Giáo dục Tiểu học – Mầm non, Trường Đại học 
Đồng Tháp.

Hình 1. Giao diện cài đặt EndNote

- Chọn I would like a 30-day free trial ở cửa 
sổ Select Installation và nhấp vào Next.

- Tiếp tục nhấp Next ở cửa sổ tiếp theo.
- Đến cửa sổ End User License Agreement 

chúng ta chọn I accept the license agreement và 
nhấp vào Next.
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- Tiếp tục chọn Next đến khi xuất hiện cửa 
sổ EndNote X7 has been successfully installed.

- Cuối cùng, chúng ta chọn Finish và khởi 
động lại máy tính để hoàn thành quá trình cài đặt.

2.2. Xây dựng ngân hàng danh mục tài liệu 
tham khảo với phần mềm EndNote

Để tạo một ngân hàng danh mục tài liệu tham 
khảo trên phần mềm EndNote, chúng ta chọn File 
→ New… (Hình 2), đặt tên và lưu lại ngân hàng.

Hình 2. Tạo ngân hàng tài liệu tham khảo

Hình 3. Thêm một tài liệu tham khảo

Lưu ý: Để truy xuất, quản lý thuận lợi danh 
mục tài liệu tham khảo và tránh trùng lặp chúng ta 
nên tạo một ngân hàng tài liệu tham khảo duy nhất.

Sau khi tạo được ngân hàng tài liệu tham 
khảo, chúng ta cần đưa các danh mục vào ngân 
hàng này. Có nhiều cách để thực hiện như: lấy dữ 
liệu từ website, từ các tệp *.pdf, nhập thông tin 
trực tiếp… Bạn đọc có thể tìm hiểu chi tiết vấn đề 
này tại [5]. Sau đây, chúng tôi trình bày cách nhập 
thông tin trực tiếp.

- Đầu tiên, chúng ta thêm tài liệu vào ngân hàng 
bằng cách chọn References → New References 
(Hình 3) hoặc nhấp chuột vào nút , xác định 
loại tài liệu như bài báo (Journal Article), sách 
(Book), một mục trong sách (Book Section), luận 
văn (thesis), trang web (Web Page)… trong hộp 
thoại Reference type.

- Tiếp theo, chúng ta nhập vào các thông tin 
cần thiết cho tài liệu như Hình 4. Trong các thông 
tin cần nhập, chúng ta cần lưu ý cách nhập họ và 
tên của tác giả tài liệu tiếng Anh và tài liệu tiếng 
Việt khác nhau. Đối với tác giả tài liệu tiếng Anh 
chúng ta ghi fi rst name, last name (tên, họ và 
chữ đệm), ví dụ: “Morgan, Frank”; “Anh, Nguyen 
Van”. Đối với tác giả tài liệu tiếng Việt chúng ta 
ghi đầy đủ họ và tên thêm dấu “,”, ví dụ: “Nguyễn 
Văn Anh,”. Nếu tài liệu có nhiều tác giả thì chúng 
ta viết tên mỗi tác giả trên một dòng.

- Sau khi nhập các thông tin, chúng ta chọn 

File → Save (Ctrl + S) và File → Close Refer-
ence (Ctrl + W) để lưu tài liệu tham khảo và trở 
về ngân hàng.

Chúng ta lập lại quá trình này đến khi nào nhập 
đủ danh mục tài liệu tham khảo vào ngân hàng. Khi 
đó, chúng ta có thể mở tệp Microsoft Word để trích 
dẫn tài liệu tham khảo.

Hình 4. Nhập thông tin cơ bản cho tài liệu
2.3. Trích dẫn các tài liệu trên phần mềm 

EndNote vào tệp Microsoft Word
Sau khi cài đặt phần mềm EndNote vào máy 

tính thành công thì chúng ta sẽ thấy Ribbob End-
Note X7 khi khởi động phần mềm Microsoft Word 
(Hình 5). Chúng ta chọn vào nút Go to EndNote để 
kiểm tra xem Word có kết nối với EndNote thành 
công chưa. Nếu kết nối thành công thì cửa sổ của 
EndNote được bật lên. Khi đó, chúng ta nhấp tổ 
hợp phím Alt+1 hoặc nhấp vào biểu tượng  
từ cửa sổ của EndNote để trở về Microsoft Word.

Để trích dẫn tài liệu tham khảo từ ngân hàng 
của EndNote, chúng ta thực hiện như sau:

- Nhấp chuột vào nút Insert Citation và chọn 
Insert Citation (Hình 5).

- Trong cửa sổ EndNote X7 Find & Insert 
my Reference, chúng ta nhập vào tên tác giả hoặc 
một vài từ trong tên tài liệu vào Textbox và nhấp 
vào nút Find (Hình 6).

- Sau khi EndNote liệt kê ra danh mục các tài 
liệu tham khảo, chúng ta chọn tài liệu cần trích dẫn, 
nhấn vào nút Insert. Ví dụ như trong Hình 6 chúng 
ta sẽ được (Wikipedia 2014).

Hình 5. Ribbon của EndNote trên Microsoft Word
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- Trong trường hợp chúng ta muốn được kết 
quả trích dẫn dạng Wikipedia (2014) thì chúng 
ta nhấp chuột vào nút Insert và chọn Insert & 
Display as: Author (Year).

- Sau khi tài liệu tham khảo được trích dẫn thì 
nó sẽ được chèn vào cuối tệp Word. Chúng ta kiểm 
tra xem định dạng như thế có phù hợp chưa. Nếu 
định dạng đó chưa phù hợp thì chúng ta chọn lại 
định dạng khác hộp thoại Style trong Ribbon của 
EndNote. Trong trường hợp không có định dạng 
nào phù hợp với yêu cầu thì chúng ta xem Mục 0 
để thiết lập định dạng mới.

Hình 6. Chèn trích dẫn và tệp Microsoft Word

2.4. Thay đổi định dạng trích dẫn
Nếu các định dạng tài liệu tham khảo đã có 

không phù hợp với yêu cầu thì chúng ta thực hiện 
một trong hai cách sau để tạo ra định dạng theo 
ý muốn.

2.4.1. Lấy định dạng tài liệu tham khảo từ 
website

Đối với các bài viết bằng tiếng Anh thì Thom-
son Reuters đã tạo hơn 6000 định dạng [6]. Đối 
với bài viết bằng tiếng Việt thì chúng tôi đã thiết 
lập một số định dạng thông dụng. Các bạn có thể 
tham khảo tại địa chỉ:

https://www.dropbox.com/sh/7vzq8ttqgh4riv6/
AAB98KWCQFp5MFcbY3woO0qoa?dl=0

Để sử dụng các định dạng này, chúng ta thực 
hiện như sau:

- Truy cập và website, download tệp định dạng 
*.ens về máy tính.

- Nhấp chuột hai lần vào tệp *.ens vừa 
download về để mở nó bằng EndNote.

- Trên cửa sổ EndNote, chúng ta chọn File → 
Save As…, đặt lại tên và chọn Save.

- Chọn định dạng mới bằng cách chọn Select 
Another Style trên Ribbon EndNote. Trong hộp 
thoại EndNote X7 Style, chúng ta chọn định dạng 

phù hợp và chọn OK. Ví dụ chọn định dạng tài 
liệu của Tạp chí Khoa học Đại học Đồng Tháp 
như Hình 7.

Hình 7. Chỉnh lại định dạng tài liệu tham khảo
2.4.2. Tự tạo định dạng tài liệu tham khảo
Để tạo ra một định dạng tài liệu tham khảo 

riêng trên phần mềm EndNote, chúng ta thực hiện 
như sau:

- Chọn một định dạng gần giống với định dạng 
mà chúng ta cần.

- Chọn Edit → Output → Styles Edit “…”. 
Khi đó, EndNote hiển thị một cửa sổ để chúng ta 
thay đổi định dạng trích dẫn và danh mục tài liệu 
tham khảo (Hình 8).

- Trường Template trong mục Citations được 
dùng để thay đổi hiển thị trong trích dẫn. Ví dụ 
[Bibliography Number] sẽ hiển thị trích dẫn theo 
yêu cầu của Tạp chí Khoa học của Trường Đại học 
Đồng Tháp.

Hình 8. Thay đổi định dạng trích dẫn và danh 
mục tài liệu tham khảo

- Trường Template trong mục Bibliography 
được dùng để thay đổi cách hiển thị các danh mục 
tài liệu tham khảo.

- Trường Layout trong mục Bibliography dùng 
đánh số hoặc ký hiệu danh mục tài liệu tham khảo. 

- Trường Sort Order trong mục Bibliography 
dùng để sắp xếp danh mục tài liệu tham khảo. Nếu 
chúng ta muốn sắp xếp theo một tiêu chuẩn khác 
với mặc định thì chúng ta chọn mục Order… và 
lựa chọn thứ tự sắp xếp.
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2.5. Hoàn thành bài viết 
2.5.1. Tách riêng hai danh mục tài liệu tham 

khảo tiếng Anh và tiếng Việt
Để chia danh mục tài liệu tham khảo thành 

danh mục tiếng Anh và danh mục tiếng Việt, chúng 
ta thực hiện như sau:

- Nhập vào từ Anh trong trường Language 
cho tất cả tài liệu tiếng Anh.

- Nhập vào từ Viet trong trường Language 
cho tất cả tài liệu tiếng Việt. Nhập tên của tác giả 
đầu trường Notes theo qui ước:

+ Â → A1, Ă → A2;
+ Đ → D1; 
+ Ê → E1;
+ Ô → O1; Ơ → O2;
và bỏ qua các dấu sắc, huyền, nặng, hỏi, ngã. 

Ví dụ: Ân → A1n, Bộ → Bo1, Đầy → D1a1y.

Hình 9. Tách tài liệu tiếng Anh và tiếng Việt
- Chọn Edit → Output → Styles Edit “…”, 

chọn trường Sort Order trong mục Bibliography 
và đổi lại thứ tự sắp xếp như Hình 9. 

Lưu ý: Nếu bạn đọc sử dụng định dạng 
LuanvanAnhViet.ens thì chúng ta không phải 
thực hiện bước cuối.

2.5.2. Chuyển về tệp Microsoft Word thông 
thường

Sau khi tệp Word được biên soạn hoàn chỉnh, 
sẵn sàng gửi đến các tạp chí hoặc đồng nghiệp, 
chúng ta cần phải đưa tệp Microsoft Word về định 
dạng Plain Text, không bị ảnh hưởng bởi mã của 
EndNote. Chúng ta tạo ra tệp sao lưu từ tệp gốc 
như sau:

- Chọn  Convert Citations and Bibliography 
trong Ribbon EndNote.

- Chọn Convert to Plain Text trong danh 
sách (Hình 10).

Hình 10. Chuyển tệp Word về dạng Plain Text

- Chọn OK trong hộp thoại yêu cầu chúng ta 
xác nhận loại bỏ các mã của EndNote. 

Sau khi đưa tệp Word về định dạng plain text, 
chúng ta có thể định dạng lại font, cỡ chữ, giãn 
dòng của tài liệu tham khảo. 

3. Kết luận và thảo luận
Phần mềm EndNote là một trong những phần 

mềm hỗ trợ quản lý và biên soạn tài liệu tham khảo 
trên Microsoft Word tốt nhất hiện nay. Nó có rất 
nhiều chức năng và công cụ ưu việt. Bài báo chỉ 
trình bày sơ lược về cách dùng EndNote tạo ngân 
hàng danh mục tài liệu tham khảo, trích dẫn vào 
tệp Word, thay đổi định dạng trích dẫn, danh mục 
tài liệu tham khảo, sắp xếp và phân loại danh mục 
tài liệu tham khảo tiếng Anh và tiếng Việt. Qua 
bài viết, chúng ta thấy rằng khi kết hợp EndNote 
và Microsoft Word thì việc trích dẫn tài liệu tham 
khảo được thuận tiện, thay đổi định dạng trích 
dẫn cũng như định dạng tài liệu tham khảo nhanh 
chóng, việc sắp xếp thứ tự các tài liệu tham khảo 
được thực hiện tự động và số tài liệu trích dẫn vừa 
đủ với số tài liệu cần tham khảo trong bài viết. Hơn 
nữa, việc các tạp chí lớn hỗ trợ trích dẫn các bài 
báo cho EndNote và EndNote có thể tự trích xuất 
tài liệu tham khảo từ tệp pdf sẽ giúp ích rất nhiều 
trong việc xây dựng ngân hàng tài liệu tham khảo. 
Mong muốn của chúng tôi trong bài viết là giới 
thiệu một cách đơn giản, ngắn gọn để bạn đọc sử 
dụng phần mềm hữu ích này vào việc viết các báo 
cáo và bài báo khoa học. 

Bên cạnh EndNote, có nhiều phần mềm 
khác hỗ trợ quản lý tài liệu tham khảo tốt như: 
Mendeley, Zotero, RefWorks, Papers… Trong số 
đó, hai phần mềm miễn phí Mendeley và Zotero 
đang nhận được sự quan tâm và sử dụng nhiều. 
Chúng có thể chạy được trên các hệ điều hành 
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Windows, Linus, iOS. Ngoài những chức năng 
cơ bản tương tự như EndNote, Zotero còn có mở 
rộng cho trình duyệt Firefox nên thuận lợi trong 
trích xuất tài liệu tham khảo từ web. Mendeley 
cho lưu trữ miễn phí 1GB trên Website. Tuy 
nhiên, đây là các phần mềm còn khá non trẻ so 

với EndNote nên chúng bị hạn chế về các kiểu 
định dạng, chức năng tìm kiếm tài liệu tham khảo 
trong ngân hàng và hỗ trợ lấy tài liệu tham khảo 
trực tiếp từ website của nhà xuất bản… Bạn đọc 
có thể tham khảo so sánh chi tiết giữa 3 phần 
mềm trên tại [1], [3]./.

Tài liệu tham khảo
[1]. Barnard College (2015), Which citation tool should I use?, Truy cập từ: https://library.barnard.

edu/fi nd-books/guides/which-citation-tool.
[2]. Đại học Đà Nẵng (2013), Hướng dẫn sử dụng căn bản EndNote, Truy cập từ: http://jse.ued.
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EDITING BIBLIOGRAPHIES ON A MICROSOFT WORD FILE WITH 
THE ENDNOTE SOFTWARE FUNCTION 

Summary
EndNote is a software package used to process bibliographies when writing essays and articles. It 

is produced by Thomson Reuters. In this paper, we introduce how to use the EndNote software to build 
a bibliography bank, to cite and sort automatically bibliographies in a Microsoft Word fi le, to change 
citation styles and bibliography styles, to split bibliographies into English and Vietnamese ones.
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